How to Use the E-Canvass File

Description: The E-Canvass file is generated from the tabulation system. The file is a
comma delimited text files (a file where fields are separated by a comma). The file
contains detailed election information including the race, precinct, legislative district,
county council district, congressional district, counter group, candidate, registered voters,
times counted, times blank voted and times over voted. In smaller elections, it is possible
to download then import this data into Microsoft Excel or any other spreadsheet
application for further analysis. For large elections, King County Elections recommend
importing the file into a database such as SQL Lite, Foxpro, Microsoft Access, or others
as the data file is large and most spreadsheets have a limitation on the number of rows.
For Mac users EagleData and Bento are popular database products.

Below are recommended procedures for importing this data into Excel and Microsoft

Access.

To upload data using Microsoft Excel, follow the procedures listed
below.

* Download the E-Canvass zip file(s) to your PC.

File Download

Do you want to open or save this file?

[l%ll Mame: AbsentesCanvassMarl3.zip
Type: Compressed (zipped) Folder, 55.6 KB

From: wis, metroke, gow

[ Open ]I Save I| Cancel |

Always azk before opening this twpe of file

While files from the Intermet can be uzeful, zome files can potentially
harm wour computer, If you do not trast the zource, do not open or
zave thiz file. What's the rizk?

* Click the Save button to save the file to your computer and bring up the
following window.



Save As @

Savein | () CANVASS v O 2 ®E
'_2_ ) Mayz005
i [B AbsenteeCanvassMarl3. zip
ty Fecent
Documents
,—,-[-:
Deszktop

)

by Documentsz

o

kdy Computer

- |

File name:

M heenteeCanvazsMarl 3.zip b | [ Save ]

by Metworl, Save as bype: | Compressed (zipped] Folder A | [ Caricel ]

¢ Select where on your computer you wish to save the zip file then click Save

Download complete

N
= Downlaad Camplete

Saved:

AbsenteeCanvassMarl 3. zip from wies, metroke, goy

(O T T T LT T T T
Downloaded: 55.6 KB in 1 sec

Download to: CACAMY,, \AbsenteeCanvassiMarl 3, zip

Transfer rate; 55.6 KEfSec

[ IiCloze thiz dialog box when download completes

[ Open ] [DpenEDIder] [ Cloze l

* After the download is complete, click the Open Folder button to bring up the
following window.



& CANVASS
File Edit ‘Wew Favorites Tools  Help -#'

O Back -\) L@ p search Hfi‘ Falders v
: Address |E;| CHCANYASS V| &e
Size | Tvpe Date Modified
File and Folder Tasks File Folder 5{31/2005 10:36 AM|

SEKE o d (zippe,,.  9/4f2007 12:20 PM
®[i Rename this file ompressed (zippe [,

[y Move this file
L Twpe: Compressed (zipped) Folder
) Copy this file Date Madffied: 9/4/2007 12:20 PM

&3 Publish this file to the teb Size: 55.6 KB
() E-mail this file
¥ Delete this file

Other Places

ag Local Disk (20

Iy Dacuments
i My Computer
& My Mebwark Places

Details

il | B
Type: Compressed (zipped) Folder Date Madified: 9/4/2007 12:20 PM Size: 55.6 KB i My Computer
* Double click the downloaded zip file to create your E-Canvass file and open

the following window.




8| AbsenteeCanyassMar13.zip

=13
File Edit ‘Wew Favorites Tools  Help 11'

eBack - \_) L@ /:\J Search || Folders '

: Address |[D CCANYASS|AbsenteaCanvassiMarl 3.zip v| o

Marne Type Packe. .. Has ... Size  R... Date

Folder Tasks & Text Document SEKE Mo 953KE  95% 3(25/2007 10:35 Al

[#] Extract all files

File and Folder Tasks

[y Move this filz
[ Copy this file
& Publish this file to the Yeb
¥ Delete this fil

Other Places

) CANWASS
G My Documents
\a Iy Metwork Places

Details

1 objects selected

* Next, double click the file in the window to open the file.

2 AbsenteeCanvass.txt - Notepad

File Edit Farmat Yiew Help

:Race“,“Precinct”,“LEG“,”CC“,“CDunterTyEe
CITY OF SEATTLE ADWISORY MEASURE MO .
"CIT¥ OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADWISORY MEASURE MO.
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO,
"CIT¥ OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADVISORY MEASURE MO,
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO,
"CIT¥ OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADVISORY MEASURE MO,
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO.
"CITY OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADVISORY MEASURE MO,
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO.
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE M.
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO.
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE M.
"CITY OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO.
"CITY OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADWVISORY MEASURE M.
"CITY OF SEATTLE ADWISORY MEASURE MO,

“,“CDunterGrDup”,“CDunt”
SEA 11-1256","11","8", "NO", "Absentea",128

1" "Times Blank voted", "ahsentee",12
"Times Counted", "absentes",171
"Times owver wvoted", "abhsentee", 0
YES", "ahsentes", 31
mMo", "absentee", 92
Times Blank voted", "ahsentee",éd
"Times Counted"”, "Absentes",l1l5
"Times owver wvoted", "abhsentee", 0
"yES", "Absentes",17
"nMo", "Absentee", 83
"Times Blank voted", "ahsentee",13
"Times Counted"”,"absentes",113
"Times owver wvoted", "abhsentee", 0
"yES", "Absentes",17
"nMo", "Absentee",173
"Times Blank woted", "absentee", 2l
"Times Counted"”, "absentes", 257
"Times owver wvoted", "abhsentee", 0
"vES", "Absentes", 63
"nMo", "Absentee",120
"Times Blank wvoted", "absentee", s
"Times Counted"”, "absentes",l157
"Times owver wvoted", "abhsentee", 0
"vES", "Abhsentes", 20
Mot Mabsentee",134
"Times Blank wvoted", "absentee",14
"Times Counted"”, "absentes",181
"Times owver wvoted", "abhsentee", 0
"vES", "Absentea", 33
Mot "absentea", 74
"Times Blank woted", "absentee", 6
"Times Counted", "ahsentes",112
"Times owver wvoted", "abhsentee", 0
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* Next, under the File menu select Save File As option to open the next
window.

ky Fecent
Dacuments

=
[
Dezktop

2

by Documents

by Computer

.«

by Metwork,

Save jn: | age Local Digk [C:] V| 0 ? ¥ v
|C)6492575b77F391 Zabeadf 10313 [Ty MovO4Input
G2 AmDY [ChoverUnder
== |=3Program Files
G Creports RECYCLER
2y chineseFonts [CIReports
|y CurrentElection ICiResults
|-5)dE backup February 15 System Yolume Information
ICIDELL [ WINDOWS
|C1Documents and Settings I'ij hz bk
) DRIVERS [Z] Laresults.txt
| helections
IEY
IIsa6
IC3IKCR RECOUNT
IC3My Downloads
File name: |.-’-'-.I::senteeEan'-.fass.t:-:t b | [ Open
Save as ype: | Text Documents [F ket w | [ Cancel
Encoding: |,&,N5| " |

* Select the folder you wish to save the E-Canvass file into. Remember the
name and location of this file.

*  Open Microsoft Excel and create a new spreadsheet.

*  Under the Data tab, select Import External Data then Import Data as in the
following window.




&) fle Edt Vew Isert Format Tooks fon_tHelp -8 x
DEEHS™ SRY| s @Y = B o -3 -1 - B U B s %, W@
ia [ ] Dﬁ Filter »

A - P Fam

A B C D] sibotds i 1 J K L M N 0 P Q R s T U v W X =
i ] Valdation. . |

Table.

Test to Columns. o
Consdlidate..,
Group and Outine »

[ eivotTable and Pivatchart Report...

9 [ mmport External pata » [ trport pata

F Mew web Query.

13 6 hlew Database Query,

a
10« » »il\Sheetl { Sheet? / Sheetd / Il [ i

Select Data Source

lookin: [ canvass x| e~ @& X .5 EE - Tooks~
() May2005
A,
My Documents
Desktop
*]
Favaorites
=]
]
Iy Metwark
Pl i g
aces File: name: | j Mew Source, ., | QOpen
Files of type: |AII Data Sources (*,odc;*.mdb; *.mde;*.ade; *.adp;*.udl;*.dsn;* xls;* . hemy *.heml; *.asp; *.mht; *j Caniel

* Select the location of your file then double click on the file name to bring up
the next window.



Text Import Wizard - 5tep 1 of 3

The Text \Wizard has determined that wour data is Fixed Width,
If this is correct, choose Mext, or choose the data type that best describes wour data.

Criginal data type
Choose the file type that best describes your data:

e - Charackers such as commas or tabs separate each field,
" Fixed width - Fields are aligned in colurmns with spaces bekween each field.
Stark import at row: 1 El: File origin: 437 1 OEM United States j

Preview of file CHiCaNYa3s AbsenteeCanyass, bk,

"Pace", "Precinct" , "LEG" "CC","CounterType", "CounterGroup" " Coud -
"CITY OF SEATTLE ADWISORY MEASTTRE NO. 1", "SEA 11-1ZE5g"_ "11", "g"

"CITY OF SEATTLE ADWISORY MEASTDRE NO. 1", "SEA 11-1&E8g" _ "11", "&2"
"CITY OF SEATTLE ADWISORY MEASURE NO. 1", "SEA 11-125g6", "11", "3"
"CITY OF SEATTLE ADWISORY MEASURE MO. 1", "SEL ll—lZEE","ll","S"_:J

| il
Cancel | | Mext = | Einish |
M

ake sure that you opt for a Delimited type of import then click the Next button
to get the following window.

- |m|m|w|N|H

Text Import Wizard - S5tep 2 of 3

This screen leks vou set the delimiters wour data contains. You can see
b wour bext is affected in the preview below,

Delimiters
[ [~ Semicolon v Comma

[ Space [ oCther: l_ Teok gualifier: | hd

[ Treat consecutive delimiters as one

Daka preview

PFace Frecinct LEZ |[CC Ko
CITY OF SEATTLE ADWISORY MEASURE NO. 1 BER 11-1FZE&5 Q11 ] A0
CITY OF SEATTLE ADWISORY MEASURE NO. 1 FER 11-1FE5&6 11 =] Time
CITY OF SEATTLE ADWISORY MEASURE NO. 1 FEA 11-1ZE5& 11 = Time
CITY OF SEATTLE ADWISORY MEASURE MO. 1 BEA 11-12E&8 Q11 3] Time]

1 | L
Cancel | < Back | Bext = | Einish |

* Make sure the settings are exactly as above then click the Next button.
* This window appears.




Text Import Wizard - 5tep 3 of 3 @@

This screen lets wou select each column and set Column data Format
the Daka Format, ¥ General
‘General' converts numeric walues ko numbers, date " Text
walues bo dates, and all remaining values to text, © Date:  |MDY -

" Do not jrmport calurnn (skip)
advanced. ..

Daka preview

! ) ConcrConcrians
I LEG [EKC  Cound ™
CITY S AD ¥ MEALSURE MO “EL 11-12E55 L1 | Mo :‘
CITY 2 0BT MEASURE NO. BEL 11-1256 L1k Time
CITY : ‘ S0RY MEASURE NO. BEL 11-1256 L1 B Time
CITY {E ADVISORY MEASURE MO. =EL 11-1256 L1 | Time] o

| 2

Cancel | < Back |

e Click the Finish button to bring the E-Canvass file into Microsoft Excel.
* Using Microsoft Excel, you can now analyze the E-Canvass file from your
PC.

To upload data using Microsoft Access, follow the procedures listed
below.

* Download the E-Canvass zip file(s) to your PC.



x]

File Download

Do you want to open or save this file?

[l%lh Mame: AbsenteeCanvassMarl3.zip
Type: Compressed (zipped) Folder, 55.6 KB
From:  wias, metroke, goy

[ Open ]I Save ]| Cancel |

Alwayz ask before opening this tupe of file

YWhile filez from the Internet can be useful, zome fles can potentially
harm your computer. 1f pou do nat trust the zource, do not open or
zave this file. What's the rigk?

Click the Save button to save the file to your computer and bring up the
following window.

Save As @

Savein: | (2 CANVASS ¥ 02 e=E
m ) Mayz00s
il Ea E.ﬁ.bsenteeCanvassMarIS.zip
ky Fecent
Documents
?[‘:
Deszktop

)

by Documents

by Computer
" File name: -"J'.I:n:z:er'utEEI:Zar'u'-.-'a:z::5:?--1ar'l 3.zp w | [ Save l
by Metwark Save az lype: | Comprezsed [zipped] Folder w | [ Cancel ]

Select where on your computer you wish to save the zip file then click Save




Download complete

N
= Downlaad Camplete

Saved:

AbsenteeCanvassMarl 3. zip from wies, metroke, goy

(O T T T LT T T T
Downloaded: 55.6 KB in 1 sec

Download to: CACAMY,, \AbsenteeCanvassiMarl 3, zip

Transfer rate; 55.6 KEfSec

[ IiCloze thiz dialog box when download completes

[ Open ] [DpenEDIder] [ Cloze ]

* After the download is complete, click the Open Folder button to bring up the
following window.

& CANVASS FBEX)
File Edit Wew Favorites Tools Help a’

\_)Back -\_:J L@ pSearch H_ Falders v

! Address |@ CACARYASS V| e
Size | Type Date Modified

File and Folder Tasks File Folder 5f31/2005 10:36 aM|
[5] absenteeC 3.z S6KE Compressed (zippe...  9/4f2007 12:20 PM

@ Rename this file

@ Iove this file
o Type: Compressed (zipped) Folder
Copy this file Date Modified: 9/4,2007 12:20 PM

&N Publish this file to the Yeb Size: 55.6 KB
(5] E-mail this file
¥ Delete this file

Other Places

oo Local Disk (C:)

My Documents

& Iy Computer

\j Iy Metwork Places

Details

Twpe: Compressed (zipped) Folder Date Modified: 9042007 12:20 PM Size: 55.6 KB d Iy Computer

* Double click the downloaded zip file to create your E-Canvass file and open
the following window.



8| AbsenteeCanyassMar13.zip

=13
File Edit ‘Wew Favorites Tools  Help 11'

eBack - \_) L@ /:\J Search || Folders '

: Address |[D CCANYASS|AbsenteaCanvassiMarl 3.zip v| o

Marne Type Packe. .. Has ... Size  R... Date

Folder Tasks & Text Document SEKE Mo 953KE  95% 3(25/2007 10:35 Al

[#] Extract all files

File and Folder Tasks

[y Move this filz
[ Copy this file
& Publish this file to the Yeb
¥ Delete this fil

Other Places

) CANWASS
G My Documents
\a Iy Metwork Places

Details

1 objects selected

* Next, double click the file in the window to open the file.

2 AbsenteeCanvass.txt - Notepad

File Edit Farmat Yiew Help

:Race“,“Precinct”,“LEG“,”CC“,“CDunterTyEe
CITY OF SEATTLE ADWISORY MEASURE MO .
"CIT¥ OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADWISORY MEASURE MO.
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO,
"CIT¥ OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADVISORY MEASURE MO,
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO,
"CIT¥ OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADVISORY MEASURE MO,
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO.
"CITY OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADVISORY MEASURE MO,
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO.
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE M.
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO.
"CITY OF SEATTLE ADWISORY MEASURE MO,
“CITY OF SEATTLE ADWISORY MEASURE M.
"CITY OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADWISORY MEASURE Mo,
"CITY OF SEATTLE ADWISORY MEASURE MO.
"CITY OF SEATTLE ADWISORY MEASURE MO,
"CITY OF SEATTLE ADWVISORY MEASURE M.
"CITY OF SEATTLE ADWISORY MEASURE MO,

“,“CDunterGrDup”,“CDunt”
SEA 11-1256","11","8", "NO", "Absentea",128

1" "Times Blank voted", "ahsentee",12
"Times Counted", "absentes",171
"Times owver wvoted", "abhsentee", 0
YES", "ahsentes", 31
mMo", "absentee", 92
Times Blank voted", "ahsentee",éd
"Times Counted"”, "Absentes",l1l5
"Times owver wvoted", "abhsentee", 0
"yES", "Absentes",17
"nMo", "Absentee", 83
"Times Blank voted", "ahsentee",13
"Times Counted"”,"absentes",113
"Times owver wvoted", "abhsentee", 0
"yES", "Absentes",17
"nMo", "Absentee",173
"Times Blank woted", "absentee", 2l
"Times Counted"”, "absentes", 257
"Times owver wvoted", "abhsentee", 0
"vES", "Absentes", 63
"nMo", "Absentee",120
"Times Blank wvoted", "absentee", s
"Times Counted"”, "absentes",l157
"Times owver wvoted", "abhsentee", 0
"vES", "Abhsentes", 20
Mot Mabsentee",134
"Times Blank wvoted", "absentee",14
"Times Counted"”, "absentes",181
"Times owver wvoted", "abhsentee", 0
"vES", "Absentea", 33
Mot "absentea", 74
"Times Blank woted", "absentee", 6
"Times Counted", "ahsentes",112
"Times owver wvoted", "abhsentee", 0

(B

[l o st el et il et el sl sl sl el ataed el s el

| £




* Next, under the File menu select Save File As option to open the next
window.

Save jn: | age Local Digk [C:] V| 0 ? ¥ v
m |C)6492575b77F391 Zabeadf 10313 [Ty MovO4Input
i 2} [ChoverUnder
My Fecent |=3Program Files
Docurents RECYCLER.
- 2y chineseFonts [CIReports
=
[ |y CurrentElection ICiResults
Desktop |-5)dE backup February 15 System Yolume Information
ICIDELL [ WINDOWS
. |C1Documents and Settings |'3=_°°] hz bk
.-..f' |C)DRIVERS |':=_°°] Laresults. kxt
lecti
by Documents Dslections
[IEV
) IIsa6
ij IC2IKCR RECOUNT
L IC3My Downloads
by Computer
‘g File name: |.-’-'-.I::senteeEan'-.fass.t:-:t b | [ Open
My Metwork. | Save as bype: | Text Daocuments [* ket w | [ Canicel
Encoding: |,&,N5| " |

* Select the folder you wish to save the E-Canvass file into. Remember the

name and location of this file.

*  Open Microsoft Access.
* Create a new dB as show in the following window.




Microsoft Access |Z”E”zl
DR EEY| 2R - % R e of - |3,
File Edit Wiew Insert Tools  Window Help Twpe a queskion for help +
4 Mew File v X
Open a file
Ecanvass.mdb
AYLLMDE

Ecanvass.mdb
ResToweh.mdb
= More files...
New
Elank Database
Blank Data Access Page
Project (Existing Data)
Project (New Data)

Mew from existing file

E Choose file. ..

Mew from template
General Templates. ..
@ Templates on Microsoft, com

5 Add Metwork Place. .
@ Microsoft Access Help
[w| Shaw at skartup

Ready MM SCRL

* Select the New Database option on the right side of the window.
* In the next window specify where you want the database to be located on your
PC and the name you wish to call it.

File New Database

Savein: |5 CAMVASS | & & 7 5 E - Tooks~

Siayae

Hiskaory

&

My Docurments

Fawaorites

File: narne: I.ﬂbsenteeCanvass.mdb ﬂ Create I
Save as bype: IMicrosoFt Access Dakabases (*.mdb) j Cancel d|




¢ (Click the Create button to create the database.
* A new blank database window will appear as follows.

Ed Microsoft Access
NDeHdB EEY | &BR - % A-Hx ag - ),

File Edit Wiew Insert Tools ‘Window Help Type & question for help =

g AbsenteeCanvass : Database (Access 2000 file format) |:||§||X|

Objects z
Tables Create table by using wizard
Create table by entering data

Queties
Forms
Reparts
Pages
Macros

Modules

£ |
&
Z
@

Groups

@ Favorites

Ready MM SCRL

* Next, under the File menu, select Import under the Get External Data option.




Microsoft Access

B B - W R e | B oS &E-| B,

Edit  Wiew Insert  Tools  Window Help Type a question For help

Mew.., CErl+m
Cpen... (7Yl ccess 2000 file format) |_||E|[z|

Get External Data ->| % Import...

+E  Link Tables...

y Using wizard
1 AbsentesCanyvass. mdb v entering data
2 Si\Canwvassing\Ecanvass.mdb

3 D:\CurrentElectiont,. . \AYL.MDE

4 D\ CurrentElectionEcanvass.mdb

¥

I Macras
3 Modules

Groups

@ Favorites

Reardu RN SR
* Specify the location, name, and File type (Text File) of the E-Canvass file.
L]
Import
Lookin:  [[5) CANVASS x| - & 7 4 B - Tooks -
MName Size  Tvpe
E] AbsenteeCanvass bt 953 KB Text Document
Histary [ Mayz005 File Folder

i

My Documents

Deskiop

Fawvarites

Ty work hdl il ] B

Places File name: I.ﬂbsenteeCan\-’ass.txt| ~l Import I
Files of type: IText Files (*.bxt;*, vy ™ tab;*, asc) j Cancel d|

* Click The Import button to bring up the next window.




Bl Import Text Wizard E|

Your data seems to be in a 'Delimited Format., IF it isn't, choose the Format that more correctly
describes vour data,

" ‘Dielimited - Characters such as comma or tab separate each field

" Fized Width - Fields are aligned in colurnns with spaces between each Fisld

ple data From file: CACANYASSVABSEMTEECAMNYASS. THT,

"Race”, "Precinct™”, "LEG", "CCH, "CounterType™, "Counteriy &
MCITY OF SEATTLE ADVIZORY MEASURE MO, 17, "3EL 11-1Z25
"CITY OF SEATTLE ADVISORY MEASURE Mo, 17, "3EL 11-125
MCITY OF SEATTLE ADVISORY MEASURE MO, 17, "3EL 11-125
"CITY OF ZEATTLE ADVISORY MEASTURE MO, 17, "3EL 11-125
"CITY OF JEATTLE ADVISORY MEALASURE o, 17, "3EL 11_125ﬂ

]
Advanced... Cancel | Mext = | Einish |

* Make sure the Delimited option is selected then click next to bring up the
following window

L
]
=

RRRREE

1§

B Import Text Wizard

What delimiter separates wour fields? Select the appropriate delimiter and see how wvour bext
is affected in the preview below,

Choose the delimiter that separates your fields;

" Tah " Semicalon * Comma " Space " Other: I_
IV {First Row Contains Field Names Text Qualifier; | -
Race Precinct LEG

CITY OF 3IEATTLE ADVISORY MEASTURE NO.
CITY OF 3EATTLE ADVISORY MEASTRE NO.
CITY OF 3EATTLE ADVISORY MEAITRE NO.
CITY OF 3IEATTLE ADVISORY MEASTRE NO.
CITY OF 3IEATTLE ADVIZORY MEASTRE NO.
CITY ©OF 3IEATTLE ADVIZORY MEASTRE NO.

= Ty TN v FmEmT vy 3 m vy ey vy apry oy saryrney  ay

SEL 11-1256 [11 ﬂ
SEL 11-1256 [11

SEL 11-1256 [11
SEL 11-1256 [11
SEL 11-1256 [11

BREL 11-1550 11 _J
-

™ i = i

‘ ]
Advanced. ., Cancel < Back | Mext = | Einish |

* Make sure all the settings are exactly as above then click the Next button.

N N




* In the next window choose the In a New Table option and click the Next
button

B Import Text Wizard @

¥ou can store your data in a new table or in an existing table,

Where would vou like o store vour data?

g In a Mews Table
" In an Exjsking Table: -

Race Precinct LEG
LITY OF SEATTLE ADVISZORY MEALASURE NO. BEL 11-1256 (11 fﬂ
ICITY OF SEATTLE ADVISZORY MELIURE NO. BEL 11-1256 (11
ICITY OF SEATTLE ADVISZORY MELIURE NO. BEL 11-1256 (11
ICITY OF SEATTLE ADVISORY MELIURE NO. BEL 11-1256 (11
CITY OF SEATTLE ADVISORY MELSTURE NO. BEL 11-1256 (11

CITY OF SEATTLE ADVIZORY MELSTURE NO. BEL 11-1550 (11 :j

= Ty TN v FmEmT vy 3 m vy ey vy apry oy saryrney  ay

4
Advanced. ., Cancel | < Back | Mext = | Einish |

¢ In the next window, click the Next button.

B Import Text Wizard E

Yau can specify information about each of the figlds wou are imparking,  Select Figlds in the
area below, You can then modify field information in the 'Field Options' area.

N N

Field Options
Field Mame: m Data Type: |Text j
Indexed: [t4o ~| T Donat import field (Skip)

Precinct LEG
11-1256 11 | =
11-1256 (11

11-1256 (11
11-1256 (11

11-1256 |11
11-1550 |11 _J
-

ki ]
Advanced... Cancel < Back | Mext = | Einish |




* The next window will ask if you want a primary key. A primary key speeds
up searches and queries but is only recommended for those with some
database experience. For this demonstration, we will not assign a primary
key.

Bl Import Text Wizard E|

Microsaft Access recommends that yvou define a primary key For
L= vour new kable, A primary key is used to uniquely identify each

PR record in your table. Ik allows wou to retrieve data more guickly,
FAFTHR R
Fonnnowwmounn i
 — (~ Let Access add primary ke,
LR " Choose my own prirmary ke, | j
(& Mo primary key, :
Race Precinct LEG

CITY OF 3IEATTLE ADVISORY MEASTURE NO.
CITY OF 3EATTLE ADVISORY MEASTRE NO.
CITY OF 3EATTLE ADVISORY MEAITRE NO.
CITY OF 3IEATTLE ADVISORY MEASTRE NO.
CITY OF 3IEATTLE ADVIZORY MEASTRE NO.
CITY ©OF 3IEATTLE ADVIZORY MEASTRE NO.

= Ty TN v FmEmT vy 3 m vy ey vy apry oy saryrney  ay

SEL 11-1256 [11 ﬂ
SEL 11-1256 [11

SEL 11-1256 [11
SEL 11-1256 [11
SEL 11-1256 [11

BREL 11-1550 11 _J
-

N N

™ i = i

‘ ]
Advanced. ., Cancel < Back | Mext = | Einish |

* Click the Next Button to get the following window. If you want to name your
table something other than what it has defaulted to, do so in the Name Table
text box.




B Import Text Wizard [z|

That's all the information the wizard needs ko import your data,

[ Iwould like a wizard to analvze my kable after impaorting the
data.

[ Display Help after the wizard is finished.

Advanced... Cancel < Back | Einish |

Click the finish button to create your table.
You will get a confirmation of this process. Click the OK button.

Import Text Wizard

1 ) Finished importing file "2 CaNYASS AbsenteeCanyvass, bxt' to table 'AbsenteeCanyvass',

* You may now use Microsoft Access to sort, query, and analyze your table.



